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Oracle AutoVue VueLink for Oracle WCC

Preface

The Oracle AutoVue VueLink for Oracle WCC User s Manual describes the key features of the VueLink.

For the most up-to-date version of this document, go to the AutoVue Documentation Web site on the Oracle
Technology Network at https://www.oracle.com/technetwork/documentation/autovue-091442 html

Audience

The Oracle AutoVue VueLink for Oracle WCC User s Manual is intended for customers who use the VueLink to
access their Oracle WebCenter Content system.

Related Documents

For more information, refer to the following documents:

o System Administrator Manual
*  Security Guide
*  Release Notes

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an action, or
terms defined in the text.

italic Italic type indicates book titles, emphasis, or placeholder variables for which you sup-
ply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in examples,
text that appears on the screen, or text that you enter.

Oracle Corp.
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Introduction

Oracle AutoVue VueLink for Oracle WCC provides an interface between the Oracle WebCenter Content server and
Oracle AutoVue, Client/Server Deployment. This interface enables you to add powerful viewing and markup
capabilities to your WebCenter Content via a Web browser in an intranet or the Internet.

- ORACLE '
|- VueLink B Oracle
| AutoVue l/ WwWCe

VueLink and AutoVue provide you with the following functionality:

*  Document viewing of native formats.

*  Graphically marking up documents using a rich set of graphical and textual tools.
*  Reviewing your markups and the markups of your coworkers.

*  Full security linking to the Docbase access control list (ACL).

Note:

*  Throughout this manual the family of AutoVue Products is referred to as AutoVue. The AutoVue family of
products includes AutoVue Office, AutoVue 2D Professional, AutoVue 3D Professional Advanced, AutoVue
EDA Professional, and AutoVue Electro-Mechanical Professional.

*  Refer to the AutoVue Supported File Formats document for further information about the file formats supported
by each AutoVue product.

Functional Overview

Oracle AutoVue VueLink for Oracle WCC adds document viewing and markup capabilities to the WebCenter
Content server. Through the use of a web browser in an intranet/internet environment, VueLink provides a seamless
interface between the WebCenter Content server and the AutoVue server.

Markups/annotations/redlines are automatically saved in the library defined in WebCenter Content during the
VueLink installation and are available for other users to edit or view depending on their access level to that library.
This means users can save markups for documents for which they have read-only access if the permission is granted
for the markup library.

VueLink and AutoVue provide users with the following powerful features and capabilities, locally or remotely via a
Web browser:

*  Securely view documents in their native format without editing them.

e View hundreds of 2D, EDA, 3D Engineering, and Business document formats.

*  Simultaneously work with multiple markup layers and files.

*  Create markups/annotations/redlines directly on stored documents or renditions using a rich set of annotation
tools.

*  Create hyperlink connections to other related documents.

*  Consolidate several Markup files (perhaps from different reviewers) into a single Markup file.

*  Associate markups with a specific document revision. Markups may be migrated to new revisions as required.

*  Graphically compare different revisions of engineering drawings or 3D Assemblies.

*  Print documents with headers, footers, and watermark information queried from specified document attributes.

VueLink also provides you with a basis to which other powerful functions can be added via custom designed tools to
further enhance your WebCenter Content installation. Custom designed tools offer many possibilities. For example,
you can create an “intelligent” custom stamp, such as an Engineering stamp, that queries for information that can be
included as markups.

AutoVue is fully configurable for you to customize your own tools. If you prefer, contact your account manager or
our customer support representatives to discuss the possibilities of our designing a tool to meet your specific needs.

Oracle Corp.
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Why does the WebCenter Content User Need a
Viewing and Markup Tool?

Typically in an organization, a document has a life cycle and is routed to several people as part of a workflow cycle.
As a minimum, there are three types of people who interact with a document:

*  Creator or Author of a document: The creator is usually the person responsible for creating or modifying a
document with an editing application such as Microsoft Word or AutoCAD.

e Reviewer of document: This individual usually reviews a document and provides comments to the author other
reviewer. In a paper-based environment, the document is printed on paper and sent to a list of reviewers. Each
reviewer provides feedback in several ways, annotates the paper output directly using a pen, attaches sticky
notes, and creates one or more annotation documents. The annotated document, along with other material, is then
sent to a supervisor who reviews the material—possibly from several reviewers and may consolidate the
comments into one set. This set is then passed back to the creator to modify the document. Several revisions or
version of the document may be produced during this process.

e Users of document: Once the review cycle is complete, possibly involving several version of the document, the
document is published. The final document is made available to those requiring view-only access to the
document. At this stage, the document may be provided for viewing either in its native format or as a print
rendition.

VueLink provides the capability of marking up a document and storing markup information as an annotation file in
the WebCenter Content library. There are different types of markup entities offered in addition to hyperlink
capabilities.

Markup File Management

More than one Markup file can be attached to a document. In addition. users have the options of displaying multiple

Markup files simultaneously. If the document currently displayed has registered markups, a Markup Indicator -
displays in the lower left corner of the status bar, alerting the user to the existence of one or more Markup files.
Markup files also automatically track the revisions of a document so that each revision has a distinct set of related
Markup files. When markups are valid for a subsequent revision they can be promoted to that particular revision.

Other Useful Features

Compare

The Compare feature is a very useful for finding similarities and differences in different version of a drawing. With
this feature, documents of the same type—raster, vector, or 3D—are visually compared. The two selected files
display simultaneously in their own windows while the comparison findings display in a third viewing window.

Engineering Documents

VueLink is fully equipped to handle complex engineering documents that may consist of external references, layers,
and blocks.

Oracle Corp.
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Viewing Documents

For example: Attp://myserver:16200/cs

Run your Web browser, and then go the WebCenter Content home page.

File Edit View History Bookmarks Tools Help EI@
E Guest Home Page x |
&« c 6] e w Seat In @ =
ORAC|E welcome to WebCenter Content

FULL ACCESS

@l Login

GUEST ACCESS

Log in to use the content server with your full access privileges

Use the navigation items below to access public content only.

@ Home
ﬁ Library
\‘% Search

[Login] [Home] [Library] [Search]

2

Click Login. If prompted, enter your username and password.

Oracle Corp.
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The Search page appears.

File Edit View History Bookmarks Tools Help EI@
E Home Page for weblogic X
— G o (6 ) e | | Q Search In @ =

ORACLE WebCenter Content weblogic | Logout | Help O

Search  Mew Chedk-In Qui Search

~ My Content Server ~Browse Content  w Content Management  + Administration

Search

Title:

Content ID:
Release Date: From To

Full-Text Search:

Sort By: I Release Date |» | | Descending [ | [ Search

3 Enter the Title, Content ID, Release Date or Full-Text Search of the document in their respective fields, and then
click Search.
Note: To view the complete library, leave all the fields empty and click Search.
The Search Results page appears.
The following sections provide alternate ways in which to view a document.
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Viewing from the Search Results Page

To the right of the document you want to view, under the Actions column, click Actions ¥=| . From the menu that
appears, select View in AutoVue.

File Edit View History Bookmarks Tools Help EI@
E Search Results X
= cC @ @ B - 9% Search i @ =
[ ~ Change View ¥ Search Actions i
| Filter by Category:  + ContentType  Security Group:Public
Search Form —> Search Results
.~ Page lEl of2 @
12! Title Date ¥ Author Actions
MARKLP 15188115049 | test 3.master 2/16(18 weblogic K= (@
MARKUP 15081300517, | test 3 2/16/18 weblogic @
MARKUP 15131004177, | test 1ca 12(12/17 weblogic [S[0)] e
MARKUP_15130314340¢ | markup 1 12/11/17 weblogic LS[0)]
PO01607 3DInventor_GO_BUTTON.ipt 12/4f17 weblogic =@
P0O01608 3DInventor_STOP_BUTTON.ipt 12/4f17 weblogic =@
PO01605 3DInventor_SCREEN.ipt 12/4f17 weblogic [S[0)]
PO01606 3DInventor_ARROW.ipt 12/4 Content Information @
. Chedk Out
POD1604 3DInventor_BOTTOM.ipt 12/4 Get Native File =@
Check In Similar =
PO01603 3DInventor_BOARD.ipt 124 end link by e-mail S[O)]
. Add to Folder (T
PO01602 3DInventor_TOP.ipt 12/4 @ w
Add to Folder as Short Cut =
PO01601 3DInventor_ilearn_asm.iam 12/4 Add Link = @
View in AutoVue =
javascript:launchAV({'1801', '0°, 'Application/iam’, 'iam’) 11/3717 =] o] o E@ i

The AutoVue Client will be launched through Java Web Start. During the launch, you may have to click security
dialogs to permit this operation. If you do not want to see these security dialogs in subsequent operations, select the
"remember" checkbox in these dialogs. Once launched, the AutoVue Client will display the selected document.

Note: It is important to note the following:

The Markup Indicator # on the left side of the AutoVue status bar indicates that one or more Markup files
are associated with the current document.

A Resource button {j on the left side of the Autovue status bar indicates that one of the components required
to accurately and fully display the document is missing. Resources consist of fonts, External Reference Files
(XRefs), and other resources. Click this button for details about the missing information.

If a document has other files associated with it, as is the case with XRefs, AutoVue checks out all the
associated fields as well.

To view a file from a local disk or network drive, click File Open ¥

Viewing Markups with the Markup Icon

If a file has associated markups, a Markup icon appears to the right of the Info @ icon.

To view how many markups are in the file, you can hover the mouse cursor over the markup icon to view tooltips.

When you click on the Markup icon, all markups that belong to the file display in the Search Results page.
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Viewing from the Content Information Page
1 To the right of the document you want to view, under the Actions column, click Info @.
The Content Information page appears.
File Edit View History Bookmarks Tools Help EI
E Content Information for '3DIn. X
&« a @ a Bl e w Search N 8 =
ORACLE wWebCenter Content weblogic | Logout | Help O fis
I\ -] | Qui;:k Search
~ My Content Server + Browse Content  ~ Content Management -~ Administration
Content Information
~ Content Actions | ~ E-mail _]
ContentID: P001601 Chedc ut
Revision: 1 Update b
Type: Document- Any generic document Check.In Similar
Title: 3DInventor_ilearn_asm.iam Subscribe
Author: weblogic Add Attachments
Comments: Export to TIFF
Profile: Export to PDF
Template Type: View in AutoVue
Superseded Date: Add to Folder as Short Cut
Superseded Twice: L |
wwxRelatedContentTriggerDate: =l
Markup_BasedID: 0
MarkupCounter: 0O
MarkupType:
Security Group: Public
Checked Out By:
Status: Released
Formats: Applicationfiam
Links
Web Location: hitp://
Mative File: 3DlInventor ilearn asm.am
Related Content: Show (+)
WCC Viewer:  hitpil!
Revision Release Date Expiration Date Status Actions
[1] 12/4/17 8:26 PM Mone Released Delete
Jjavascript:launchAV() -

2 From the Content Actions menu, select View in AutoVue.

Viewing a Revision

To view a specific revision of a document, do the following:

1 Scroll to the bottom of the Content Information page, and under the Revision column, click the link to go to that

particular revision content information page.
The Content Information page loads the specified revision.
2 To view the document, from the Content Actions menu, select View in AutoVue.

Oracle Corp.
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Accessing Files Stored in the Backend WebCen-
ter Content System from AutoVue

WebCenter Content Search allows you to access files that are in the backend WebCenter Content system from within
the AutoVue window. Using WebCenter Content Search from within the repository, you can open files for viewing,
comparison, cross-probing, mockup, bath printing, overlays and hyperlink markups. When opening an file, the File
Open dialog appears to enable you to search the repository.

Note:

*  To open files that are on the local file system, from the AutoVue client, click the File menu and then select Open
Local File.

*  To open URLs from the Autovue client, click the File menu, select Open URL, and then enter the desired URL
to display.

WCC Search

To search for files in the WebCenter Content search, perform the following:

1 From the File menu, select Open.
The File Open dialog appears.

1 Click WCC Search.
The Search dialog appears.

E File Open @

Lookin: | Application Data ~| T E-

B
Recent Items

Desktop

e

WCC

ra

Search WCC

—
.!I
' - File name:
1]
WEbWRL  Flesoftype: [ allFies - Cancel |

2 To search for a file in the WebCenter Content, enter the Content ID, Release From Date, Release To Date, and/
or other search attributes of the file in the WCC Search dialog.

Oracle Corp.
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3

Click Search.

AutoVue looks for all documents in the repository that matches the search criteria and populates the Search

results section.

=

Look in: | [ Search Results 2

o =1
= 1
RecentItems |1
1

1

| =
Desktop =911
= 2
P>
wce 2
33

13

rJ"‘ £ 321700-001 c.drw.1
Search WCC

< >

“‘I
' = File name:

Web URL

Files of type: | All Files

v ¥ &~
Enter Search Criteria:

Title:
Content ID
Release Date :From (Y¥YY-MM-DD)

Release Date :To (YYYY-MM-DD)

Search

o Cancel

From the Search Results section, select a file and then click Load File to display the file in AutoVue.

Note: If a file has multiple versions, it appears as a root node in Search Results with the file revisions as child

nodes. Expand the file to view the revisions and corresponding information (for example, Author and

Modification Date).

Marne |Cu:untent jn |FOI|:Ier |F\uthor |Mu:u:|i|‘iu:atiu:ur
-l _assetID MARKUP_124... user_3 12 Jun 200% a
-allegro_1_w_tf nooozo user_3 12 Jun 200%
-0 _assetID MARKUP_124... user_3 12 Jun 200%

= _1_dwf _3 12 Jun 2009

wer_1_dwf ver: 2 0ooos? user_3 12 Jun 200%
g-----\v'er_D_l:IWF Wer: 1 0ooos? user_3 12 Jun 200%
-uref_hyperlink 000066 user_3 12 Jun 200
- _adencedllegro.brd BMP REMDITIOMN_1... user_3 12 Jun 200
--000006, xcsr  BMP REMDITION_1... user_3 11 Jun 200%
-hyperlink_3 00o00&3 user_3 11 Jun 200%
-hyper_z22 MARKUP_124... user_3 11 Jun 200%
~hwper_111 MARKUP_124... user_3 11 Jun 200%
~hyperlink_z 0ooo&1 user_3 11 Jun 200%
- Zd3d_111 MARKUP_124... user_3 11 Jun 2005
~hyperlink_1 000059 user_3 11 Jun 200%
-2d_3d_1 Qoaas? user_3 11 Jun 200%

< >
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Viewing Documents for Oracle WCC Desktop
Integration Suite

Oracle AutoVue VueLink for Oracle WCC supports viewing from Oracle WCC Desktop Integration Suite (DIS). To
do so, perform the following:

1

& http:/Av2k3ucm1013333/idcfidcplafwebdav/Contribution Folders/SolidWorks Assembly 2008/310-300-5

() samples to test Mobile Pack
= () Solidworks Assembly 2008
) 310-300-5029
) 310-500-5028 Znd
(2 versioned AutoCAD
Projacts
T Trash

1iemselected. 2,09 MB

Content Information

Content ID: 000025

Revision:

1

Type: ADENG - Acme Engineering Department

Title: 0310-200-595.SLDPRT 2nd

Author:

Comments:

test

Inhibit Propagation: FALSE

Folder: /Contribution

Read Only:
Hidden:

Assembly 2008/310-300-5029 Znd/

FALSE
FALSE

Force Folder Security: FALSE

OEVFAssetID:

Markup_BasedID:
OEVFWorkflowID:
MarkupCounter:

Folio_dID:

Discussion Count:

siebelSvcReg:
siebelasset:

Announcement:
Superseded Date:
Superseded Twice:

xTest:

Security Group: Public
Checked Qut By:

Status: Released

Formats: Applicationisidprt

~ Content Actions | v E-mail
View in Autolue

Email AutoVue Lirk

Check out

Updste

Check In Sirilar

Subscribe

Add to active Content Basket
Create Shortcut

~ Download

Fie Ede Wiew Favortes Tooks Help o
Qe - D (P O seaen Foders | [«] | [T [ ‘ B ‘
address [ ontribution ssembly 2008 2ndj v| B
Folders x Name Vault File Size  Type Author Security Gr... -~
(@ Deskeon () 0096-300-501 ADENG test Public
23 My Documents [E) 0000435051 5KE ADACCT test public
4 Hy Computer [Z) 000044 xesr 9KB ADACCT test Public
< Local bisk (C:) 12KB ADACCT test Public
o New volume (01) 2,142K8 ADENG test Public
{2 DVD Drive {E5) 3KE Markup test public
22 draings on bourane’ (W) 2 SKB  Markup test Public 'm
- contrel Panel &) 3050-300-501 .5L0PRT 184KB  ADENG test Public
€3 1y Network Places 3080-763-101, 5LDFRT 1235KB  ADENG test Fublic
&) Recyde Bin [Z)3050-804-101 510PRT 157K8 ADENG test public
' Hummingbird heighborhaod [Z)310-300-5023 5L0ASH B54KB ADENG test Public
& & oracke Cantert servers =) 310-300-5023. 5L0DRW 1,021 KB ADENG test Public
& 5] wakauem1013333 ) Asset_noa 1968 Markup test Public
1 ) Contribution Folders Mrk-310-300-501 SLDPRT. . ZKE Markup test public v
() Office Fies N

<

Browse the folders to select the file you want to view.
The Content Information page appears in the lower part of the window.

From the Content Actions menu, select View in AutoVue.
The file opens in the AutoVue client.

Open Windows Explorer or Microsoft Outlook (if you have Microsoft Office installed) and browse to the Oracle
Content Servers directory.

From the Oracle Content Servers directory, select one backend WebCenter Content system to connect to and
enter login information and password.
The folders contained within the repository appear.
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Managing Markup Files
Creatlng Markups

Open a document in AutoVue.
2 From the Markup menu, select New to enter Markup mode.

Note: From the toolbar, you can also click New Markup :{"

The current active document displays in Markup mode ready for you to create markups.

If you have just finished creating a Markup file and you would like to create a new Markup file, from the File
menu, select New.

Note: From the toolbar, you can also click New Markup 2~ .

3 If there are exiting markups, from the status bar, click the Markup Indicator button & The Markup Files
dialog appears.

B Markup Files

Select Markup Filels)

Mame Markup k... P.uthu:!r

normal_2 normal wehlogic

normnal_1 normal iweblogic Import

cons_01 consolidated  weblogic

[] Al vevisions

4 Click New.

Consolidating Markups

The Consolidate option allows you to create a new Markup file that combines copies of selected layers of different
Markup files.

Open the Markup files to be consolidated.

2 From the Markup menu, select Consolidate.
The Consolidate Markups dialog appears.

3 Select the markup layers to be consolidated into one file. To select multiple layers, press the Shift or Control key
while selecting.

Note: To select all the layers, click Select All. To deselect all the layers, click UnSelect All.
4 In the Markup ID field, enter an ID for the new Markup file.

If you want to open the newly consolidated markup as the active markup, select the Open as Active Markup
check box.

6 Click OK.

The consolidated Markup file is saved. If you selected Open as Active Markup, the consolidated markup opens
and is set as the active markup.
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Saving Markups

Saving a new Markup file

1 From the Markup menu, select Save.
The Save Markup File As dialog appears.

Save Markup File As

Mame review3 K

Markup Tvpe | normal w

Export
raster
consolidated

2 In the Name field, enter a name for the Markup file.
3 Make a selection from the Markup Type list:

* mnormal: Save the Markup file as a normal markup type.

* master: Save the Markup file as a master markup type. When the file is reopened, this Markup file is loaded
by default.

» consolidated: Saves the Markup file as a consolidated markup type.
4  Click OK.
The Markup file is saved and remains in the AutoVue viewing window.

Saving an existing Markup file

From the Markup menu, select Save.

The Markup file is saved and remains in the AutoVue viewing window.

Displaying Existing Markups
To view markups after opening a document in AutoVue, do the following:

1 From the Markup menu, select Open.

Note: From the toolbar, you can also click Open Markup .
The Markup Files dialog appears.

Markup Files
Select Markup Filels)

Mame Markup k... | Author
normal_2 normal wehlogic

normnal_1 normal iweblogic Import

cons_01 consolidated  weblogic

[] Al vevisions

2 To view a Markup file or files, select their respective check boxes.
If multiple Markup files are selected, select the active Markup file from the Active Markup list.
4  Click OK.

w
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Promoting Markups

It is possible to promote markups from an earlier version of a document to the current version. When markups are
promoted they are saved against the new version of the document.

After opening a document in AutoVue, do the following:

1 From the Markup menu, select Open.
The Markup Files dialog appears.

Note: From the toolbar, you can also click Open Markup & .

o
Markup Files

Select Markup Files)

Name Markup k... | Author

[ |pormal_2 normal wehlogic
[ narmal _t normal weblogic Impork
[ ] |cons_01 consolidated  |\weblogic

all revisions

2 Select the All Revisions check box. The Markup files from previous versions of the base files appear in the list.
3 Select the check box to the left of one Markup file from the previous version.
The Markup file is shown with the current version base file.

4 When you save the selected markup (with or without any modifications), it is saved as the markup of the current

base file version.

Deleting Markups

After opening a document in Autovue, do the following:

1 From the Markup menu, select Open.
The Markup Files dialog appears.

Note: From the toolbar, you can also click Open Markup & .

2 Select one or markups from the list.
3 Click Delete.
A message prompt appears as shown to let you confirm the deletion of the desired Markup file or files.

\\_:.:_/ Delete "reviews" markup file ?

[ Yes [ Mo ]

4 Click Yes. The selected Markup file or files are deleted from the list of markups. The Markup Files dialog
displays the remaining Markup files.
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Printing Headers. Footers. and Water-
marks

With AutoVue and Oracle VueLink for Oracle WCC, it is possible to print document attributes in a header, a footer,
or as a watermark.
1 From the File menu, select Print.
The Print Properties dialog appears.
2 Customize the print properties as shown in the following figure:

il

Options | Headers/Footers | watermark || Margins | Pen Settings

Insert Code: w
it <15 Weh Format > A
% orkflow State=

Vo <Comments = k

%o <Extension=

it <File Mame= v

Center  |%X<Release Date=

Right:  |%&x<File Name >
Fookers

Left: “o¥ <Publish State >

Center  |%R<Created Date

Right: |9%¥=Status>

Set Font...

[] align Ta Margins

C

Headers/Footers Group

The Headers/Footers group defines the headers and footers to be included on every printed page of the document.

1  Seclect the Headers/Footers tab.

2 To set the header and footer content, enter text in the Header and Footer fields or select text from the Insert
Code and Insert Variables lists.

3 Click Font to customize the font.

4 Click OK when finished.

Watermarks Group

A watermark prints faintly on the current document’s contents. With the Watermarks group, the watermark is defined
as it will appear on the printed document.

1 Select the Watermarks tab.

2 Enter the text in the Watermark Text box. The text displays as it will appear on the document.
3 Click Font to customize the font.

4 Click OK when finished.
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Converting Documents to Other Formats

You can use AutoVue to convert documents to other formats (for example, TIFF) and then check-in the converted
document back into the WebCenter Content repository as a separate file.

Note: TIFF, PDF, and BMP are the currently supported formats for saving to the backend WebCenter Content

system.
1 Open a document in AutoVue.
2 From the File menu, select Convert.
The Convert dialog appears.
3 From the Convert to Format list, select the TIFF format.
4  Select the Rendition option.
5 Modify any other options as required.
6 Click OK.

File conversion begins. AutoVue converts the file to the TIFF format and checks it into the WebCenter Content
repository as a separate file.

Oracle Corp.



Oracle AutoVue VueLink for Oracle WCC 19

File Compare

With the Compare feature, you can visually compare documents of the same type—raster, vector, or 3D. The two
selected files display simultaneously in their own windows while the comparison findings display in a third window.
This feature is very useful for finding similarities and differences in revisions of a drawing.

With AutoVue, you can compare any two versions of a document.

After opening a document in AutoVue, do the following:

1

2

From the Analysis menu, select Compare.
The File Open dialog appears.
Select a version from the Document Versions list.

Note: To select a file through WCC Search or Browse, rather than select a version from the Document Version
list, deselect the Document Versions check box.

To search through the backend WebCenter Content system, click WCC Search, specify the search criteria, and
then select a file from the search results.

To select a local file, click Browse. Browse through the local file system and select a file.

Note: To specify a URL, enter the URL in the File Name field.

Click OK after you select a file.

In comparison mode, AutoVue displays the files in three windows: the first window contains the original
document, the second window contains the version to compare against, and the third window displays the
comparison result.

The comparison result window uses a color scheme to communicate the result of the file comparison:

Color Description

Green An addition to the document.
Red A deletion from the document.

Blue No changes.
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Cross Probing

AutoVue lets you specify files saved in the WebCenter Content repository for cross probing.

Display a document with AutoVue.

2 From the Analysis menu, select Cross Probe.
The Select Files for Cross Probing dialog appears.

Click Browse to select a file from the local file system.

4  Click WCC Search to select a file from the backend WebCenter Content system.
Note: To specify a URL, enter the URL in the File Name field.

5 Click OK.

For more information on accessing the backend WebCenter Content system using WCC Search, refer to Accessing
Files Stored in the Backend WebCenter Content System from AutoVue.
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Batch Print

With AutoVue, you can print a set of files in a single batch. You can also select files that are in the backend
WebCenter Content system to add to the list of files to be printed.

1 From the File menu, select Batch Print.
The Batch Print dialog appears.

2 Click Add to add files to the list of files to be printed.
The File Open dialog appears.

3 To search through the backend WebCenter Content system, click WCC Search, specify the search criteria, and
then select a file from the search results.

4  Click Browse to select a file from the local file system.
Note: To specify a URL, enter the URL in the File Name field.

5 Click OK.
The selected files appear in the list of files to be printed.

6  To print these files, click Print.
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File Overlays

AutoVue allows you to specify a file saved in the backend WebCenter Content system for an overlay.

Open the file you want to use as the base file for the overlay.

2 From the File menu, select Import File as Overlay.
The Overlay dialog appears.

3 Click Add.
The Please Select an Overlay dialog appears.

4  Select a file to overlay and then click Open.
To add another file to overlay, repeat steps 3 through 4.

6  When done, click OK.
The base file displays with the selected overlays.

For more information on accessing the WebCenter Content repository using WCC Search, refer to Accessing Files
Stored in the Backend WebCenter Content System from AutoVue.
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Stamp

The Stamp markup entity lets you create a stamp that includes document and user information (metadata) pulled
directly from the backend WebCenter Content system.

When a Stamp is added, it automatically retrieves the current value of the attributes from the document records.
However, it is possible to change these values and set the new values back into the system through the Stamp.

To use the Stamp, a stamp definition and background image should be setup by the administrator. Oracle AutoVue
VueLink for Oracle WCC comes with a predefined stamp and image. The default stamp includes the following:

e Document's Title

¢ Document's Author

¢ Document's Creation Date
¢ Document's Revision

For information on adding and creating an Stamp, refer to Oracle AutoVue User s Manual.
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Appendix A: Feedback

If you have any questions or require support for AutoVue please contact your system administrator. If at any time you
have questions or concerns regarding AutoVue, please contact us.

General AutoVue Information

Web Site  https://www.oracle.com/us/products/applications/autovue/index.html

Blog https://blogs.oracle.com/enterprisevisualization/

Oracle Customer Support

Web Site https://www.oracle.com/support/index.html

My Oracle Support AutoVue Community

Web Site https://communities.oracle.com/portal/server.pt

Sales Inquiries

Web Site  https://www.oracle.com/corporate/contact/global.html
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